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Toon Boom Harmony 16.0.1
Here is a list of changes in Harmony 16.0.1, build 14405.
l

Features on page 3
l

Master Controller on page 3

l

Drawing on page 4

l

Performance on page 4

l

Scripting on page 5

l

Enhancements on page 6

l

Fixed Issues on page 7

Features
Master Controller
Feature

Description

Editions

Master Controllers created with the Interpolation Grid wizard in
Harmony 16.0.1 or later will display a rectangle around the space in
which you can move the 2D point widget, allowing you to see where the
point is positioned relative to its boundaries.
Bounding box for
Interpolation Grid

Increased performance

Premium

Master Controllers created in Harmony 16.0.1 or later will have
significantly better performance. Manipulating these Master Controllers
will update your character rig much faster, and displaying these Master
Controller's controls will have a much smaller impact on application
performance and playback speed.
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Drawing
Feature

Description

Editions

The following modifier keys, which could be used when drawing with
the

Brush tool and

Pencil tool on a vector layer, can now be

used when drawing with the

Stamp tool, as well as when drawing

with the Brush tool on a bitmap layer:
l

If you press and hold the Shift key before you start drawing, your
stroke will be a straight line.

l

Modifier keys for Stamp and
Bitmap Brush tools
l

l

l

Cut on several layers

If you press and hold the Shift key while you're drawing, the part
of your stroke from that point on will be a straight line until you
release the Shift key.
If you press and hold the Shift and the Alt keys before drawing,
your stroke will be a straight line in an angle that is a multiple of
15 degrees.
If you press and hold the Ctrl (Windows/Linux) or ⌘
(macOS)Ctrl (Windows) or ⌘ (macOS) key while drawing, your
stroke will be a closed shape.
If you press and hold the Alt key, your tool will snap in a straight
line to the nearest existing shape.

You can now use the

Cutter tool on all visible layers simultaneously

by holding the Ctrl (Windows/Linux) or ⌘ (macOS) key.

You can now use the
Use the Perspective tool on
several layers

Use the Envelope tool on
several layers

Essentials,
Advanced,
Premium

Perspective tool on several layers

simultaneously by selecting all the layers you want to work with in the
Timeline view, then selecting the artwork you want to edit with the
Perspective tool.

You can now use the

Envelope tool on several layers simultaneously

by selecting all the layers you want to work with in the Timeline view,
then selecting the artwork you want to edit with the Envelope tool.

Essentials,
Advanced,
Premium

Essentials,
Advanced,
Premium

Essentials,
Advanced,
Premium

Performance
Feature

Description

Editions

Audio playback

Audio playback performance has been significantly enhanced to
prevent it from slowing down scene playback.

Essentials, Advanced,
Premium
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Feature

Description

Editions

Interactive Camera View Cache

A new preference, Enable Interactive Camera View Cache (Beta),
has been added to the OpenGL tab of the Preferences dialog.
When enabled, the Camera view will cache its preview image
and reload parts of it when moving the mouse cursor around or
when manipulating control boxes and control points.

Advanced, Premium

To enable this feature, check the Enable Interactive Camera
View Cache (Beta) preference in the OpenGL tab of the
Preferences dialog.

Scripting
Feature

Description

Editions

Script permissions

The File list of the Script Editor view now has a Permissions column,
which indicates whether each script in the list can be edited or not.

Essentials,
Advanced,
Premium

Importing scripts and related

When importing a script, any user interface (.ui) or icon (.png) file that
is in the same directory as the script and has the same file name will be

Essentials,
Advanced,

automatically imported along with it.

Premium

files

Testing scripts from global
scope

It is now possible to test or debug a script from the global scope rather
than through a specific function. This can be useful if you want to test
code blurbs before structuring your script in functions.
To do this, when setting the target function to test in the Script Editor,
select <Nothing> in the functions list.

Essentials,
Advanced,
Premium

3D Model information

The new Model3d class can be used to obtain information about a 3D
model such as its transformation matrix as well as the name and
hierarchy of its sub-nodes.

Premium

3D sub-node information

The new SubnodeData class can be used to obtain information about a
sub-node in a 3D model.

Premium

Exporting movies in batch
mode

It is now possible to use the exporter.exportToQuicktime()
method when running a script from a command line interface.

Essentials,
Advanced,
Premium

Obtaining the full attribute

The new fullKeyword() method of the Attritube class returns the

Essentials,
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Feature

Description

Editions

keyword

attribute's full keyword, including the keyword for each of its parents.
For example, for the attribute with the keyword OFFSET.Z, the
fullKeyword() method returns "OFFSET.Z", whereas the older
keyword() method only returns "Z".

Advanced,
Premium

Get column name of attribute

The new columnName() method of the Attribute class returns the
name of the column the attribute is linked to.

Essentials,
Advanced,
Premium

Higher decimal precision

The node.getTextAttr() and column.getEntry() methods can
now return up to four decimals of precision rather than three, which is
the amount of precision supported by most input fields in the user
interface.

Essentials,
Advanced,
Premium

Set bitmap and bitmap texture
resolution

The new changeDrawingBitmapLayerResolution() and
changeDrawingVectorLayerResolution() methods of the
DrawingTools class can change the resolution of bitmap drawings as
well as the texture resolution of vector drawings, respectively.
Additionally, the new
setDefaultTexturePixelDensityforBitmapDrawings() and

Advanced,
Premium

setDefaultTexturePixelDensityforVectorDrawings() methods
of the scene class can set the default pixel density for bitmap drawings
and textured vector drawings for the current scene.

Enhancements
l

Until Harmony 15.0.0, pressing the Spacebar key would reset the angle of the bounding box when manipulating an
element with the Transform tool. This behaviour has been restored in Harmony 16.0.1.

l

Views in the Windows top menu are no longer separated in two lists. They are now all listed together and in
alphabetical order.

l

When selecting the peg of a camera layer with the

Transform tool, the camera frame now displays in the colour

selected in your colour preferences for selecting pegs.
NOTE
To change this preference, in the top menu, select Edit (Windows/Linux) or Harmony [Edition]
(macOS) > Preferences, then open the General tab, click on Edit Colours and, in the Colours dialog,
open the Camera tab. The preferences are named Peg: Animate Current Frame, Peg: Animate Onion
Skin Range and Peg: Animate Off.
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Fixed Issues
l

Harmony fails to connect to the license server when its port and address are specified in the TOONBOOM_LICENSE_
FILE environment variable in the port@hostname format.

l

Harmony may crash after customizing the Tools toolbar if the Flat Tools Toolbar preference is enabled.

l

Rare crash when exporting a QuickTime movie from a scene with deformations applied to a drawing layer with the
Preserve Line Thickness layer property.

l

Harmony uses 100% of the available CPU power when downloading scene assets from Harmony Server to the local
cache while opening a scene.

l

Possible crash when closing a scene containing Master Controllers.

l

A blank welcome screen appears when opening a scene directly from Finder on macOS 10.14 (Mojave).

l

Glow effects are not rendered when chained with a Cutter effect.

l

3D Path with control point becomes corrupted when moving element in

Animate Off or

Animate Onion Skin

Range mode.
l

When a Layer-Selector node is connected under a Pass Through Composite, its effect is not visible in the OpenGL
preview of the Camera view.

l

Black rectangles may appear in the OpenGL preview of the Camera view if the scene has OpenGL-Cache-Lock
nodes.

l

The user interface of the Onion Skin view is not scaled up when running Harmony on a High DPI/Retina display.

l

Several frames are skipped when playing a scene for the first time since opening it on macOS.

l

Double-clicking on the icon of a layer in the Timeline view does not open its Layer Properties dialog.

l

Duplicating a column in the Xsheet view does not duplicate its Key and Breakdown markers.

l

Impossible to use function keys (F1, F2, etc.) in keyboard shortcuts on macOS.

l

When a port is selected in the Node view, selecting a node in the Node view does not deselect the port.

l

After adding a parent peg to a node, selecting another node and attempting to add a parent peg to it adds the
parent peg to the previously selected node instead.

l

The

Advanced Onion Skin and

Shift and Trace buttons are not available in the Tools toolbar when the Flat

Tools Toolbar preference is enabled.
l

The Animation Mode options of the Tools toolbar are still listed in a drop-down instead of as separate buttons when
the Flat Tools Toolbar preference is enabled.

l

Harmony does not always display error messages when audio playback fails.

l

Position and zoom level of Node View sometimes changes when manipulating a Master Controller.

l

When manipulating a Master Controller and there are several Camera views in the workspace, the other Camera
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views do not update immediately.
NOTE
This issue will only be fixed in Master Controllers created in Harmony 16.0.1 or later. Master Controllers
created in prior versions will still have this issue.

l

Colour of Colour-Card appears lighter when selecting artwork with the

Select tool if the Enable Rendering

Caching of Composite Nodes preference is on.
l

When the Select Synced Layers option of the Timeline view menu is enabled, layers that are clones of the current
layer also get selected.

l

Clicking on a drawing with the

Transform tool with the

Peg Selection Mode tool property enabled does not

select its parent peg if the drawing is connected to a deformation that uses a Transformation-Switch.
l

When using the

Shift and Trace tool during a camera movement and using Ctrl + click (Windows/Linux) or ⌘ +

click (macOS) to select one of the drawings in the Onion Skin, the control box of the Shift and Trace tool is offset
from the selected drawing.
l

If Onion Skin was enabled when the scene was opened, clicking on the Onion Skin button in the Tools toolbar only
opens the drop-down menu, making it impossible to use this button to disable Onion Skin.

l

If an Apply-Peg-Transformation node is connected under an OpenGL-Cache-Lock node, the OpenGL preview gets
constantly regenerated.

l

When importing a template with groups while Publish Attribute Mode is enabled, the Publish to Parent Group
option of the imported groups is always enabled.

l

The Camera view does not immediately display drawings in their undeformed version when selecting the
Rigging tool.

l

Plug-ins that are packaged with Harmony are not loaded when developing plug-ins with the Harmony SDK on
macOS.

l

If a script in the scene directory has the same name as a script in the user preferences directory, attempting to edit
and save the scene script may fail.

l

Icons and tool tips for scripts added to the Scripting toolbar cannot be customized.

l

3D Path functions may end up with several keyframes in the same frame, causing their motion path to be corrupted.

l

If a drawing is connected to an OpenGL-Cache-Lock node which is connected to an Apply-Peg-Transformation
node, manipulating the peg of the Apply-Peg-Transformation node may cause the drawing to flicker around the
Camera view.

l

When pressing and holding E to use the

Eraser tool, the tip is always square-shaped regardless of which tip

shape is currently selected.
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l

When pressing and holding V to use the

Stroke tool, the

Draw Strokes as Straight Lines and

Connect

Line Ends tool properties are ignored.
l

The

Auto-Flatten tool option of the

l

Switching between the

Brush tool does not work when drawing with a semi-transparent colour.

Perspective and the

Envelope tool while having multiple drawings selected discards

the selection and leaves only one drawing selected.
l

If the user uses the

Select tool with the

enabled, then clicks on the

Permanent Selection and the

Apply to All Frames tool properties

Create Colour Art from Line Art button in the Tool Properties view, the colour art will

be generated on all drawings in the current drawing layer, but only for the artwork inside the permanent selection.
However, the way the permanent selection is applied to drawings in other frames does not take in account the
offset from the drawing layer's parent peg.
l

Pasting artwork with the

Perspective or

Envelope tool does not work if the

Apply to All Frames tool

property is enabled.
l

Animating in

Animate Onion Skin Range mode does create keyframes on all of the element's functions when

the Set Keyframes on all Functions with the Transform Tool preference is enabled.
l

The Generate Auto-Matte command does not work if the

Select tool's

Apply to Visible Drawing Layers tool

property is enabled.
l

The Reduce Drawing Texture Resolution command is applied to all visible drawing layers if the

Select tool's

Apply to Visible Drawing Layers tool property is enabled.
l

When using any drawing tool with the

Apply to Synced Drawing Layers tool property enabled on a drawing

layer that has been cloned, the tool affects the current layer and its clone layers, even if the drawings exposed on
either layers are different.
l

When the

Eraser tool is used with the

Apply to Synced Layers tool property enabled, the offset of the

parent peg of the synced layer is not applied to the position of the eraser.
l

When using the

Reposition All Drawings tool with the

enabled and the

Light Table mode on, layers that are synced with the current layer appear semi-transparent,

Apply to Synced Drawing Layers tool property

whereas layers that are affected by the current tool should always appear opaque.
l

When using the

Stroke tool with the

Apply to Synced Layers tool property enabled and the

Light Table

mode on, the layers that are synced with the current layer appear semi-transparent, whereas layers that are
affected by the current tool should always appear opaque.
l

Using the

Eraser tool on a bitmap layer with the

Apply to Synced Drawing Layers tool property enabled

only erases on the currently selected drawing layer.
l

Using the

Eraser tool on a bitmap layer with the

Apply to Line Art and Colour Art tool property enabled only

erases on the current art layer.
l

The Set Target dialog of the Script Editor view lists script in Harmony's Plugins directory, which cannot be edited
in the Script Editor.
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l

The scene.checkoutLock(), scene.checkOutDate() and scene.checkOutUser() methods always return
the default value.

l

When renaming a drawing layer, its name does not update in the Drawing Substitutions view.

l

The OK and Cancel buttons of the Add Frames dialog are in the wrong order on macOS.

l

The movie file types mov, mp4, mkv and wmv are listed in the File Type drop-down of the Export Images dialog
in Harmony Essentials and Harmony Advanced. Attempting to export in one of these file types from the Export
Images dialog did not do anything.

l

Both JPG and JPEG are listed in the File Type drop-down of the Export Images dialog in Harmony Advanced.

l

The Select Tool is Lasso preference is still present in the Preferences dialog of Paint. Since Harmony 16.0.0, this
preference is updated by selecting either Lasso or Marquee in the Tool Properties view.
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Toon Boom Harmony 16.0.0
Here is a list of changes in Harmony 16.0.0, build 14155.
l

Features on page 11
l

Harmony Server on page 11

l

Master Controller on page 12

l

Deformations on page 14

l

Digital Animation on page 14

l

Paperless Animation on page 15

l

Drawing on page 16

l

Colour on page 18

l

Effects on page 19

l

3D on page 19

l

Node View

l

Playback on page 21

l

Staging on page 21

l

Scene Settings on page 22

l

Import / Export on page 22

l

Preferences on page 22

l

Gaming on page 23

l

Scripting on page 23

l

Enhancements on page 26

l

Bug Fixes on page 27

Features
Harmony Server
Feature

Description

Editions

Local Caching

When opening a scene in a Harmony Server database, you can choose
to cache the scene's drawings locally as you open the scene. Harmony
will load the drawings from the cache on your computer instead of over

Advanced,
Premium
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Feature

Description

Editions

the network, which will increase its performance and stability when
working on heavy scenes.
If you make changes to the drawings in your scene, Harmony will
automatically upload the updated drawings back to the database when
you save, so you do not have to worry about doing it yourself.
To use the local cache, check the Cache scene assets locally checkbox at
the bottom of the Database Selector dialog when browsing for a scene
to open.

Master Controller
Feature

Description

Editions

The new Interpolation Slider wizard allows you to create a slider widget which can
be used to pose a character, or part of a character, based on a series of linear
poses.

Interpolation Slider
Wizard

Premium

You can launch the Interpolation Slider Wizard by clicking on the
Interpolatiopn Slider button in the Master Controller toolbar or by selecting
Animation > Master Controller > Launch Interpolation Slider Wizard from the top
menu.
Master Controller
Toolbar

The new Master Controller toolbar includes buttons to access the
Interpolation Grid wizard and the Interpolation Slider wizard.

12
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Feature

Description

Editions

Master Controller View

The new Master Controller view can help you quickly find, select and display
Master Controllers in your scene, so that you do not have to navigate your scene's
node system to select and display Master Controllers.

Premium

Widget Keyframes

New Master Controllers generated with one of the Master Controller wizards will
store the position of their widget in keyframes when you manipulate them. Hence,
Harmony will remember where the widget was positioned at every frame where it
was manipulated. This will allow animators to easily tweak the position of the

Premium

character from where they last set it.
Performance
Enhancements

Master Controller are now faster at reading and updating node attributes, making
their manipulation smoother and less resource-intensive.

Premium

Automatic Extra Files
Set-Up

When creating a Master Controller with the Interpolation Grid Wizard or the
Interpolation Slider Wizard, the Master Controller node will automatically have a list
of files it requires in its Extra Files parameter, so you do not have to add them
manually.

Premium

When you select a layer with collapsed children layers in the Timeline view and run
one of the Master Controller wizards, the attributes for the selected layer and all of
Monitor Attributes of
Collapsed Layers

its children will be added to the list of monitored attributes. Hence, you no longer
need to individually select all the layers which you want the Master Controller to
control. Just collapsing your layers and selecting the top peg or the top group of
your rig will be enough.

Premium

When creating a Master Controller with the Interpolation Grid or
Interpolation Slider Wizard, you can add or remove nodes or attributes on the fly:
Add/Remove Attributes

l

l

To add a node's attributes, select it in the Timeline or Node view, then click
on the Add Selected Nodes button in the wizard.
To remove a node's attributes, select its attributes in the Monitored
Attributes list and click on the

2D Point Widget Size

Premium

Remove attributes button.

The size of 2D Point Widget no longer changes when zooming in or out of the
scene, allowing you to zoom in to see any detail it obstructs, and to easily select it
even when zoomed out.
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Deformations
Feature

Description

Editions

The Envelope Creator dialog box allows you to quickly generate an
Envelope or Curve deformation chain based on the shape of your
artwork.

Envelope Creator

Premium

To use the Envelope Creator, select a drawing, then select Animation
> Envelope Creator > Create Envelope in the top menu.

By enabling the

Control Selection Mode option of the Transform tool

in the Tool Properties view, you can now select several points in a Curve
or Envelope deformation chain by drawing a lasso around them, then
manipulate all those points simultaneously.
Multiple Deformation Point
Manipulation

Premium

When one or several Curve or Envelope deformation points are selected,
you can now nudge them using the arrow keys on your keyboard.

Premium

Feature

Description

Editions

Drawing Substitutions View

The new Drawing Substitutions view displays all of the drawings
contained in the selected layer as thumbnails, and allows you to quickly
swap which drawing is exposed at the current frame simply by clicking
on it.

Essentials,
Advanced,
Premium

Nudge Deformation Points

Digital Animation
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Feature

Animate Onion Skin Range

Description

Editions

With the Animate Onion Skin Range mode, you can animate a layer or
peg on every frame in the Onion Skin range simultaneously. This can
allow you to offset the position of a layer or peg in several keyframes
simultaneously. It can also work with any range of frames, even if it does
not have keyframes, as this mode creates keyframes at the beginning
and end of the Onion Skin range if needed.

Essentials,
Advanced,
Premium

To use the Animate Onion Skin Range mode, double-click on the
Animate Current Frame button in the Tools toolbar and, in the pop-up
menu, select

Animate Onion Skin Range.

You can now hide the pivot of the selected layer when using the
Translate,
Hide Pivot for Advanced
Animation Tools

Rotate,

Scale and

Skew tools. This can be useful if

you want to avoid accidentally moving the pivot point, which, when
done with one of these tools, causes the selected layer to be offset in all
of its existing animation keyframes. To do this, click on the

Disable

Essentials,
Advanced,
Premium

Pivot Manipulator button in the Tool Properties view.

Paperless Animation
Feature

Description

Editions

The new Shift and Trace tool allows you to temporarily move, rotate and
scale drawings, then trace over them in other drawings directly in the
Camera view.
Shift and Trace Tool

To use the Shift and Trace tool, add the Shift and Trace toolbar to your
workspace, then select the

Shift and Trace tool button. Controls for

the Shift and Trace tool are in the Shift and Trace toolbar as well as in
the Tool Properties view.
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Feature

Description

Editions

Advanced Onion Skin allows you to include or exclude any of the 10
drawings before and after the current frame, as well as to set the
individual opacity of each drawing.
Advanced Onion Skin

To use Advanced Onion Skin, in the Tools toolbar, double-click on the
Show Onion Skin button and select Show Advanced Onion Skin. Then,
add the Onion Skin view to your workspace so you can configure which
drawings are displayed as well as their opacity.
When Onion Skin is enabled, the handles around the Timeline playhead,
with which you can set the amount of frames before and after the
current frame to display in the Onion Skin, have been made significantly
easier to see and to use.

Better Onion Skin Handles

Advanced,
Premium

Essentials,
Advanced,
Premium

Drawing
Feature

Description

Editions

The new Stamp tool can be used to stamp one or several drawings into
your artwork. It can be used to stamp drawings one at a time or to draw
strokes with it. The behaviour of the stamp tool when drawing strokes
can be customized in many ways.

Essentials,
Advanced,
Premium

Stamp Tool
To use the Stamp tool, simply select the

Stamp tool in the Tools

toolbar.

NOTE
The Stamp tool replaces the Dynamic Brush option of the Brush
tool in Harmony 15.0 and earlier.

16

Toon Boom Harmony 16.0 Release Notes

Feature

Description

Editions

You can now use the

Select,

Cutter and

Paint tool on

multiple drawings simultaneously. By enabling the

Apply to Onion

Skin Range tool mode in the Tool Properties, the Select, Cutter and Paint
tool can be used on every drawing displayed in the Onion Skin
simultaneously. The
Apply to All Drawings /
Drawings in Onion Skin Range

Apply to Onion Skin Range option is available

in a pop-up menu that you can open by double-clicking on the

Apply

to All Drawings button in the Tool Properties view.
It is also easier to use these tools on all drawings in the current layer.
Previously, to do this, you had to enable the Permanent Selection and
Apply to Multiple Drawings tool modes at the same time. Now, you can
just enable the

Essentials,
Advanced,
Premium

Apply to All Drawings tool mode and, as long as it is

enabled, the tool will work on all drawings in the current layer
simultaneously.

You can now use the
Pencil Editor and

Select,
Cutter,
Edit Texture/Gradient,
Paint tools on multiple layers simultaneously.

There are three approaches to editing multiple layers:
l

Apply to Selected Layers /

l

If you select multiple layers, these tools will work on all the
selected layers simultaneously.
If you enable the

Apply to Visible Drawing Layers tool mode,

these tools will work on all the visible layers simultaneously.

All Layers
l

If you enable the

Apply to Synced Drawing Layers tool mode,

Essentials,
Advanced,
Premium

these tools will work on the current layer and all layers that are
synced to it simultaneously. The

Apply to Synced Drawing

Layers is available in a pop-up menu that you can open by
double-clicking on the

Apply to Visible Drawing Layers

button in the Tool Properties view.

Relative Brush Size

The new Proportional to Camera option of the Brush and Pencil tool will
adjust the size of your brush or pencil relative to the zoom level of the
camera. This allows you to preserve your line thickness through camera
zoom-ins and zoom-outs in paperless animation productions.
To enable this option, click on the

Show Extended Properties button

Essentials,
Advanced,
Premium

in the Tool Propeties view and, in the Brush or Pencil Tool Properties
dialog, check the Proportional to Camera checkbox.

The
Easy Drag

Select,

Cutter and

Reposition All Drawings now have

an Easy Drag tool mode. When enabled, you can click anywhere inside
the selection control box to drag the selection. By default, you have to
click inside the artwork, which may be difficult when manipulating line
art.

17
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Feature

Description

Editions

To enable Easy Drag mode, click on the

Easy Drag button in the Tool

Properties view.
You can now temporarily flip the contents of the Camera and Drawing
views horizontally by enabling Mirror View.
Mirror View

To enable Mirror View, click on the

Mirror View button in the Camera

or Drawing view toolbar, or select View > Mirror View from the top

Essentials,
Advanced,
Premium

menu.
In the Tool Properties view, if you set the selection mode for the current
tool to either

Lasso or

Marquee, the mode will be automatically

saved in your preferences and will persist after you close and relaunch
Harmony.

NOTE

Lasso/Marquee Selection Mode

The selection mode can be set when using the
Select,

Cutter,

Perspective or

Contour Editor,

Transform,
Pencil Editor,

Envelope tools. Setting the selection mode

for any of these tools will change the selection mode for all of
these tools.

Colour
Feature

Consolidate Colours into a
Palette

Description

Editions

Using the Create Palette from Selection dialog box, you can now
instantly generate a palette containing all of the colours in the selected
artwork.
To use the Create Palette from Selection dialog box, select all the layers
for which you want to create a palette. Then, in the Colour View, click on
the

Menu button and select Palettes > New Palette from Selected

Drawings.

18

Advanced,
Premium

Toon Boom Harmony 16.0 Release Notes

Effects
Feature

Description

Editions

Shake Node

The new Shake node will apply an earthquake like motion to any node
rigged under it. It is an improvement on the Quake node, with a more
realistic and erratic-looking shaking motion, as well as more parameters
than the Quake node.

Premium

The new Transform-Loop node will take the animation from its parent
peg and loop it for the entire duration of the scene. This can be used to
animate the motion of a looping background only once, and let the
Transform-Loop node take care of repeating this animation. When
repeating the animation, it skips the first frame, as it is typical for the first
and last frame of a looping background to look exactly the same.
Transform-Loop Node

The default behavior of the Transform-Loop is to loop the animation
forward. By setting its Loop Type property to Ping-Pong, the
Transform-Loop node will alternate between looping the animation
forward and backward. By setting its Loop Type to Repeat and Offset, it
will accumulate the effect of the animation each time it repeats it,
offsetting the drawing rigged under it more and more each time the
animation is repeated.

Premium

Description

Editions

3D
Feature

You can now import a 3D model as a pre-rendered 2D bitmap layer. This
can be useful if you need to use a 3D model as a reference to draw
backgrounds, characters or other assets.
Render 3D Model as 2D Layer

Scale Factor

To import a 3D model as a pre-rendered 2D image, select File > Import
> 3D Models from the top menu. Then, in the Import 3D Model dialog,
check the Convert to 2D option. You will be prompted to position the
3D model before rendering it in another dialog.
You can now apply a scale factor to your 3D models. This allows you to
scale your 3D models up or down without actually changing the value of
their scale coordinate, hence changing their default size in your scene.
You can also set a default scale factor for when you import 3D models
into your scene.
To apply a scale factor to a 3D Model, locate it in the 3D Models library
of the Library view, right-click on it and select Set Scale Factor.
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Node View
Feature

Description

Editions

It is now possible to organize the connection cables in the Node view
with the use of waypoints. A waypoint can have two purposes:
l

l

It allows you to modify the trajectory of the cable. A cable will
follow every waypoint created on it.
If the cable is connected to several nodes, it allows you to decide
where the cable splits to connect to each node.

Waypoints

Premium

You can create a waypoint on a cable by clicking and dragging on the
circle in the middle of a cable in the Node View. You can also right-click
on a cable and select Create Waypoint. To connect a waypoint to
another node, hold the Shift key, then click an drag on it to create a new
cable than can be connected to a node.

Connecting Composites

If you select several nodes and create a composite, this composite will
be instantly connected to all of the selected nodes.

Premium

Keyboard Navigation

You can now navigate the Node view using keyboard keys. To do this,
you must select a node's port, then use the arrow keys to navigate from
port to port or from now to node, as well as the Enter/Return key to enter
or exit groups.

Premium

Snapping Nodes

When you move nodes in the Node view, their horizontal position will
snap to make their connection cables straight, and their vertical position
will snap to align to other nodes. This will make it easier to make cleanlooking organized node systems.

Premium

Nudging Nodes

You can now nudge the position of nodes by selecting them and
pressing the arrow keys on your keyboard.

Premium

Pass Through Cables

Node view cables that carry several layers of image information—
typically output cables of pass through composites—now appear

Premium
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Feature

Description

Editions

thicker, to differentiate them from cables that carry single layers of image
information.

Playback
Feature

Description

Editions

Mini Playback

The new Mini Playback toolbar allows you to quickly play a short span
of animation before and after the current frame. This can be useful for
previewing the part of your scene's animation that you're working on.

Essentials,
Advanced,
Premium

Persistent Start and Stop
frames

The Start and Stop frames set in the Playback toolbar are now saved in
the scene. They will persist after closing and reopening the scene.

Essentials,
Advanced,
Premium

Description

Editions

Staging
Feature

Images imported as original bitmaps can be made to tile infinitely
beyond its boundaries. Bitmap images can either be tiled horizontally,
vertically or both. This can be used to make looping backgrounds.

Tiled Bitmap Backgrounds

To tile bitmap images, open the Layer Properties dialog for the layer and,
in the Drawing tab, under Bitmap File option, check the Tile Horizontally
or Tile Vertically checkboxes—see Element / Drawing Node.

NOTE
This only works images imported as original bitmap images, not
Toon Boom bitmap drawings.
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Scene Settings
Feature

Description

Editions

Decimal Frame Rate

Harmony now supports setting the scene's frame rate to a decimal
number. This can accommodate pipelines that use 23.976 frames per
second or 29.970 frames per second as their frame rate for compatibility
with legacy standard displays.

Essentials,
Advanced,
Premium

Description

Editions

Import / Export
Feature

You can now import Photoshop Document (.psd) files in Harmony and
preserve their group and layer structure as well as the blending modes of
layers and groups.

Import PSD with Groups
and Blending Modes

The old way of importing multi-layer PSDs into Harmony, which is still
available, imported each group in the PSD file as a layer, and each layer
in the each group as a drawing in its respective layer. This new method
simply imports each layer as a layer, each group as a group, and if any
layer or group has a specific blending mode, it will be attached to a
Blending node with the same blending mode, so as to replicate the look
of the Photoshop Document as accurately as possible.

Advanced,
Premium

To import multi-layer PSDs and preserve their group, layer and blending
mode structure, select File > Import > Images in the top menu and select
your PSD file for import. Then, the Multilayer Image Import Settings
dialog will appear. In the Create drop-down, select Individual Layers.
To import multi-layer PSDs and convert groups to layers with multiple
drawings, select Groups as Layers in the Create drop-down instead.

Export Animated GIF

You can now export a scene, or part of your scene, as an animated GIF
image.
To export an animated GIF, select File > Export > Animated GIF from the
top menu—see .

Essentials,
Advanced,
Premium

Preferences
Feature

Description

Editions

Automatic Bitmap Pixel Density

If the new Pixel Density Proportional to Camera preference is enabled,

Advanced,
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Feature

Description

Editions

new drawings will have their pixel density adjusted to the camera's
current zoom level.
This preference is available at the bottom of the Drawing tab in the
Preferences dialog.
The Default Scale Factor preference allows you to set the default scale
factor for 3D models you import into your scene. You can set this option

Default 3D Model Scale Factor

Premium

Premium

in the General tab of the Preferences dialog.
You can now set the maximum cache size of the render preview as a
percentage of your machine's RAM instead of a set amount of RAM. You
can also enable or disable caching on the disk. Both preferences can be
found in the Render tab of the Preferences dialog, in the Render View
Image Cache section.

Advanced,
Premium

Feature

Description

Editions

Timeline Markers in Harmony
Essentials

Timeline Markers, a feature previously exclusive to Harmony Advanced
and Harmony Premium, are now available in Harmony Essentials to
accommodate the creation of gaming rigs.

Essentials

Render View Image Cache

Gaming

Scripting
Feature

Description

Editions

In the past, scripts packaged with Harmony were all automatically copied to your
preferences folder, in the same location as your custom scripts. Now, scripts
packaged with Harmony are only copied to your preferences if you make
modifications to them. Otherwise, they are stored and executed from the Harmony
installation folder.
Smart Script
Management

This solves several problems:
l

l

The scripts folder in your user preferences is now reserved for your custom
scripts and are no longer cluttered with Harmony scripts.
In previous versions, when installing a patch update, Harmony would not
overwrite the scripts in your user preferences with the updated scripts, as
this would risk overwriting one of your user scripts. This is no longer a
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Feature

Description

Editions

problem, except in the rare case where you happen to have edited a script
packaged with Harmony which was updated in a patch update.
l

You can now easily restore the original version of a packaged Harmony
script after having made changes to it.

You can now set a custom location in which to store scripts. To do this, you must
set the TOONBOOM_GLOBAL_SCRIPT_LOCATION environment variable to the
Custom Script Folder

Show Attribute
Information

location where you want to store scripts. The scripts in this location will be
available in the Script Editor alongside scripts that are packaged with Harmony and
scripts in your user preferences.
By enabling the Show Attribute Information option in the Node View, a button is
added next to each attribute in the Layer Properties dialog and view. Clicking on
this button will display information on how to access this attribute in the Harmony
scripting interface, as well as a sample script to store the attribute's value in a
variable.
You can enable this option by clicking on the

Essentials,
Advanced,
Premium

Premium

Menu button in the Node View

and selecting View > Show Attribute Information.
The scripting interface now provides you with a list of responders from the
User Interface
Responders

Harmony user interface. You can obtain this list with the getResponderList()
method. You can obtain the list of actions for a given responder with the
getActionList() method.

Essentials,
Advanced,
Premium

Scene Modification
Callbacks

It is now possible to bind callbacks to scene modifications using the
SceneChangeNotifier class. This class contains several signals that are
triggered when different kinds of changes are done to the scene, and which can be
bound to functions.

Essentials,
Advanced,
Premium

Perform actions on
specific nodes

It is now possible to perform actions on specific nodes by specifying their
absolute path in the Node view. Previously, the Action.perform() method
would only take two parameters: The action to executre and its target responder,
and would always work on the selected nodes only. You can now optionally
specify the target node or nodes as its third parameter.

Essentials,
Advanced,
Premium

Documentation of
widgets

Examples of how to create and configure user interface widgets has been added to
the Harmony scripting interface documentation.

Essentials,
Advanced,
Premium

Documentation of the
node class

Examples of how to use the node class have been added to the Harmony scripting
interface documentation.

Essentials,
Advanced,
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Description

Editions

Premium
Essentials,
Advanced,
Premium

Documentation of the
Attribute class

Examples of how to use the Attribute class have been added to the Harmony
scripting interface documentation.

Set the value of an
attribute at any frame

The new setValueAt method of the Attribute class can set the value of the
attribute at a specific frame rather than at the current frame.

Obtain an attribute's
sub-attributes

The new getSubAttributes() method of the Attribute class will now return
the list of the attribute's sub-attributes.

Essentials,
Advanced,
Premium

Convert a coordinate
for single axis between
fields and OpenGL
coordinates

The following methods were added to the scene class to convert the coordinate
for a single axis from field coordinates to OpenGL coordinates, and from
OpenGL to field coordinates: toOGLX(), toOGLY(), toOGLZ(), fromOGLX(),
fromOGLY() and fromOGLZ().

Essentials,
Advanced,
Premium

The new getMajorVersion(), getMinorVersion(), getPatchVersion() and

Essentials,

getBuildNumber() methods of the about class will provide their respective
values from the currently installed version of Harmony.

Advanced,
Premium

The waypoint class was added to allow you to create and manipulate waypoints
in the Node View.

Premium

Get individual version
numbers

Waypoints

Essentials,
Advanced,
Premium

It is now possible to create toolbars and views using the Harmony scripting
interface, by creating packages containing their functionalities, user interface and
assets.

Scriptable Toolbars
and Views

You can find an example of a package containing a toolbar and a view created
through the scripting interface in the
Plugins/ScriptingInterfaces/Resources/packages/MasterController
directory inside the Harmony installation directory:
l

l

l

Windows: C:\Program Files
(x86)\Toon Boom Animation\Toon Boom Harmony 16.0
[Edition]
macOS (Stand Alone): /Applications/Toon Boom Harmony 16.0
[Edition]/tba
macOS (Server): /Applications/Toon Boom Harmony 16.0
[Edition] Network/tba
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Description

l

Editions

GNU/Linux: /usr/local/ToonBoomAnimation/harmony[Edition]_
16.0

You can create user packages in the packages sub-directory of the 1600scripts directory of your user preferences. This directory is the following
location:
l

l

l

Windows: C:\Users\[username]\AppData\Roaming\Toon Boom
Animation\Toon Boom Harmony[Edition]\1600-scripts
macOS: /Users/[username]/Library/Preferences/Toon Boom
Animation/Toon Boom Harmony[Edition]/1600-scripts
GNU/Linux: /home/[username]/Toon Boom Animation/Toon Boom
Harmony[Edition]/1600-scripts

It is now possible to set the position of a Slider widget in true field coordinates.
Slider widget
coordinates in fields

Set the Extra Files
attribute of a Master
Controller or Script
Node

To do this, you must create a Point2D widget, set its position, and set this
Point2D widget as the position property of your SliderWidget. This will set the
position of your Slider widget on a true fields coordinate system. You can also use
the screen_space property of the SliderWidget class to decide if its position is
relative to the screen rather than the scene.

Premium

It is now possible to set the Extra Files attribute of a Master Controller node or
Script Node using the scripting interface. This is used by the Interpolation Grid and
Interpolation Slider wizards to set the Extra Files attribute of the new Master
Controller nodes they generate to include every file these Master Controllers
depend on.
Here is an example of how to set this attribute to "scripts/" for
a MasterController node at the root of the scene:

Premium

var colName = column.generateAnonymousName();
column.add(colName, "FILE_LIBRARY");
node.linkAttr("Top/MasterController", "files", colName);
column.setEntry(colName, 1, 1, "scripts/");

Multiply Quaternions

The multiply method was added to the Quaternion class. It allows you to
multiply the quaternion with another quaternion.

Enhancements
l

It is no longer possible to make any changes to a layer's exposure or keyframes in the Timeline view when that layer
is locked.
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l

The Layer Properties dialog now displays the type of node in its title bar. Likewise, the Layer Properties view
displays the type of node in the Type field, just under the Enable/Disable checkbox and above the Name field.

l

The

Control Selection Mode of the Transform tool can now be toggled on or off with a keyboard shortcut. There

is no default shortcut for this command, but a shortcut can be assigned to it in the Shortcuts tab of the Preferences
dialog, under General.
l

Complex operations, such as pasting a character pose using the Pose Copier, now store their Undo/Redo data in a
disk cache instead of in the RAM. This will prevent such operations from taking too much RAM in the Undo history.

l

Performance when using the Render Preview mode of the Camera view has been improved.

l

Performance when rendering images imported as original bitmaps has been improved.

l

Performance when using Master Controllers in long scenes with a lot of keyframes has been improved.

l

Users must now double-click on a layer's name in the Timeline view to rename them, to avoid making the rename
field appear by accident when selecting the layer.

l

When creating a new Harmony Server database, the sample resolution.conf file is now automatically copied to the
resolution sub-folder of the database.

Bug Fixes
l

Fixed memory leak when selecting an Alembic 3D model with vertex colours.

l

Fixed a rare crash when moving a Master Controller 2D Point widget.

l

Fixed slow rendering of drawings with deformations in the Top and Side views.

l

Fixed issue causing OpenGL Cache nodes to influence the rendered image.

l

Fixed issue where setting a workspace with Unicode characters in its name as the current workspace would make
Harmony load the default workspace on launch.

l

Fixed issue causing some layers in imported PSD files to be imported with incorrect proportions.

l

Fixed issue causing users to be prompted to activate their software when upgrading to a new version of Harmony
that requires an update to the licensing system.

l

Fixed issue where the input and output ports of a Master Controller node or Script node would not update when
changing their port configurations until the user closed and reopened the scene.

l

Fixed issue where burn-ins would be rendered in the wrong font on GNU/Linux. Burn-ins on GNU/Linux are now
rendered using the Liberation Sans font by default.

l

Fixed issue where scripted actions affecting nodes would not cause all instances of the Node View to update, if
several instances were opened.

l

Removed the Game Skinning toolbar and the Animated Matte Generator view from Paint.

l

Removed the Control Selection Mode tool property of the Transform tool from Harmony Essentials and Harmony
Advanced, as it is only useful for features that are exclusive to Harmony Premium.
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l

Fixed issue causing the scope of variables declared by a script called by the include() method to be corrupted. .

l

Fixed small a memory leak that occurred when instantiation a node containing a 3D model with the Model3D class
in the Harmony scripting interface.

l

Fixed issue causing the Select tool to sometimes fail selecting artwork in a drawing layer rigged as the parent of
another drawing layer.

l

Fixed issue causing Harmony to fail rendering some frames when a Crop node is connected between the main
scene Composite and the Write node.

l

Fixed issue causing script buttons added to a toolbar when running Harmony in Japanese or Chinese to not run and
to not display their icon.

l

Fixed a small imprecision in the coordinates reported by the Master Controller 2D Point Widget.

l

Fixed a memory leak occurring when rendering a Gaussian Blur or Box Blur effect with a matte.

l

Fixed issue causing the number input field widget (NumberEdit) created through the Harmony scripting interface
to ignore its minimum and maximum value properties.

l

Fixed issue preventing users from replacing a cable going from a group node to another node with a cable going
from a different port of the same group to the same node.

l

Fixed freeze when moving a layer attached to a composite node that is visible in the Timeline view between two
other layers.

l

Fixed issue preventing from changing the scale of a 3D model with the Transform tool when that 3D model's x, y
and z scale values are locked together.

l

Fixed issue causing the Master Controller wizards to add both a node's 3D Path and separate position functions to
the list of monitored attributes if the node had both functions in its attributes. Now, only the node's currently used
position functions are added to the list.

l

Fixed issue where creating a Master Controller with one of the Master Controller wizards would create multiple
entries in the Undo history and would hence require using the Undo command multiple times to fully undo its
creation.

l

Fixed issue causing some effects to stop working in the Render Preview mode of the Camera view, specifically when
the Transform tool is slected and the mouse cursor is in the Camera view.

l

Fixed issue causing rendered frames to have various rendering errors when a 3D model is in the scene and is
rendered through OpenGL.

l

Fixed performance issue when rendering a scene with several Colour-Override nodes.

l

Fixed issue where the middle mouse button could not be used to move nodes in the Node View when the Middle
Mouse Button Pans the View preference is disabled.

l

Fixed issue where the bounding box of a layer selected with the Transform tool would not rotate when rotating the
Camera view.
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l

Fixed issue where attempting to install an older version of Harmony over a more recent version of Harmony could
corrupt the installation on Windows.

l

Fixed issue preventing custom grid presets for the Interpolation Grid Wizard from being saved.

l

Fixed issue where GNU/Linux would add the fully qualified domain name of the machine to the Harmony Server
database's machine-list file when installing the batch processing daemon. To avoid this problem, the installer no
longer attempts to add the machine's name to the list, so it must be added manually.

l

Fixed a syntax error reported by the installer when installing Harmony on CentOS 6.

l

Fixed issue preventing the Interpolation Grid Wizard from working in Harmony Server.

l

Fixed issue causing some layers to be hidden in the OpenGL preview of the Camera view if the Enable Rendering
Caching of Composite Nodes preference is enabled.

l

Fixed issue where a Master Controller's onFrameChanged() callback would keep getting triggered after deleting
its node.

l

Fixed issue causing OpenGL anti-aliasing to stop working when the Transform tool is selected, the cursor is inside
the Camera view and the Enable Rendering Caching of Composite Nodes preference is enabled.

l

Fixed issue causing the OpenGLBypass node to process the image from a Passthrough composite as if it was a flat
image.
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